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• This guide explains how to install the software programs and 
briefly introduces their functions and operating procedures. 

• Please read the software license agreement in this guide before 
using the software. By using the software, you agree to be 
bound by the terms of the agreement. 

Software Starter Guide
(For the Canon Digital Camera Solution Disk Version 14)
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You must install the software bundled on the Canon 
Digital Camera Solution Disk before connecting the 
camera to the computer.

Install the software. Connect the camera 
to the computer.

ENGLISH



The precautions noted within this guide are intended to instruct you in the safe and correct 
use of the products and to prevent injuries or damage to yourself, other persons and 
property. Please read and ensure that you understand them before proceeding to other 
sections of the guide. 

Trademark Acknowledgments
• Canon and PowerShot are trademarks of Canon Inc.
• ArcSoft, the ArcSoft logo, ArcSoft PhotoImpression and ArcSoft VideoImpression are 

trademarks or registered trademarks of ArcSoft, Inc.
• Adobe is a trademark of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple 

Computer Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows logo are either registered trademarks or trademarks 

of Microsoft Corporation in the United States and/or other countries.
• Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape 

Communications Corporation in the United States and other countries. Netscape 
Communicator is a trademark of Netscape Communications Corporation.

• Other names and products not mentioned above may be registered trademarks or 
trademarks of their respective companies.

Copyright © 2003 Canon Inc. All rights reserved.

SAFETY PRECAUTIONS

Warnings This symbol indicates topics that could lead to death or serious injury if 
ignored or handled incorrectly.

Warnings
• Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-

ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the 
speakers. It is also possible to suffer from hearing loss from listening with headphones to 
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is 

accurate and complete, no liability can be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior 
written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards 
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.
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Canon Software License Agreement
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN 
THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS 
AGREEMENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE 
DATA) AND THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND 
PROMPTLY RETURN THE SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and 
conditions of this Agreement.
1. LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a 

single computer. You may physically transfer the SOFTWARE from one computer to another 
provided that the SOFTWARE is used on only one computer at a time. You shall not install or use 
the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.
With respect to the sound and image data (“Data”) contained in the Software, which are to be 
downloaded to the applicable Canon digital camera product, Canon grants you a personal, non-
exclusive license to use the Data on a single Canon digital camera product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE 
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING 
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE 
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and 
retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation of 
this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be 
responsible for providing maintenance or support for use of the SOFTWARE. No updates, fixes or 
support will be made available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON 
AN “AS IS” BASIS AND WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM 
storing the SOFTWARE is warranted only against defective material under normal use for a 
period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by your 
sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same 
without charge when returned by you at your expense to your point of purchase and proven to 
be defective upon inspection. The Replacement CD-ROM will be warranted for the remainder of 
the original ninety (90) day warranty period of the defective CD-ROM. The limited warranty does 
not apply if the failure of the CD-ROM resulted from accident, abuse or misapplication of the 
SOFTWARE and shall not extend to anyone other than the original user of the SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR 
CONDITIONS, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE 
SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.

READ CAREFULLY BEFORE USING
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NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OF IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH 
RESULTING FROM NEGLIGENCE ON THE PART OF THE SELLER, SO THE ABOVE 
DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO YOU.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), 
consisting of “commercial computer software” and “commercial computer software 
documentation,” as such terms are used in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 
C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.72024 (June 1995), all U.S. Government 
End Users shall acquire the SOFTWARE with only those rights set forth herein. Manufacturer is 
Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and 
regulations of the country involved, and not to export or re-export, directly or indirectly, the 
SOFTWARE in violation of any such laws and restrictions and regulations, or without all necessary 
approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court 
or tribunal of competent jurisdiction, such provision shall be null and void with respect to the 
jurisdiction of that court or tribunal and all the remaining provisions of this Agreement shall 
remain in full force and effect.

9. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

10.OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the 
SOFTWARE is subject to the laws of the United States, and Canada, and other applicable 
copyright and trademark laws, and nothing in this Agreement constitutes a waiver of the rights 
of Canon, its affiliated corporations and third party licensors under such laws. You only own the 
CD-ROM media in which the Software is stored. Except as expressly provided herein, no license 
or right, express or implied, is hereby conveyed or granted by Canon to you for any intellectual 
property of Canon. Nothing contained in Paragraph 1 shall be construed to give Canon any 
ownership rights in any images, graphics or textual material that you save in connection with the 
Software. 
You may not modify, remove or delete any or all copyright notices (i) which are contained in the 
Software, including any copy thereof, and (ii) which are on the original CD-ROM and on the 
medium of a back-up copy made pursuant to Section 2 above.

11.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE 
AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING 
THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR 
AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN 
THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO AMENDMENT TO THIS 
AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF 
CANON.



iii

Table of contents

Read This First 1

It’s so Simple! Make Prints Right at Home Like a Pro ......................2
Unbounded Possibilities with Entertaining Software .....................4
About the CD-ROMs in Your Package ..............................................6
System Requirements ........................................................................7

Using the Software on the Windows Platform 9
- Preparations -

Installing the Software and USB Driver ..........................................10

Using the Software on the Windows Platform 17
- The Basics -

Downloading Images to the Computer ..........................................18
Printing Images ................................................................................24

Using the Software on the Windows Platform 29
- Advanced Techniques -

The ZoomBrowser EX Windows ......................................................30
Checking Images before Downloading ..........................................32
Replaying Movies .............................................................................35
Searching Images .............................................................................36
Operating the Shutter Remotely ....................................................39
Merging Panoramic Images - PhotoStitch ......................................44
Saving Images on CD-R/RW Disks (Windows XP Only) ..................46
Enjoy Customizing Your Camera with the My Camera Settings ...47

Using the Software on the Macintosh Platform 55
- Preparations -

Installing the Software ....................................................................56

Using the Software on the Macintosh Platform 59
- The Basics -

Starting ImageBrowser ....................................................................60
Downloading Images to the Computer ..........................................67
Printing Images ................................................................................70



iv

Using the Software on the Macintosh Platform 73
- Advanced Techniques -

Replaying Movies ............................................................................. 74
Operating the Shutter Remotely .................................................... 75
Merging Panoramic Images - PhotoStitch ...................................... 80
Enjoy Customizing Your Camera with the My Camera Settings .. 82

Appendices 87

About the CD-ROMs Supplied with the Solution Disk .................. 88
Uninstalling the Software ............................................................... 90
Memory Card Folder Structure ....................................................... 94
Troubleshooting .............................................................................. 95

Information about Your Camera 105

Information Common to All Models ............................................ 106
PowerShot SD10 DIGITAL ELPH/DIGITAL IXUS i ........................... 108
PowerShot A80 .............................................................................. 109

Index ............................................................................................... 110



W
indow

s/M
acintosh

1

Read This First

This chapter explains what you can accomplish using the camera with the 
software contained on the Canon Digital Camera Solution Disk. 

It also lists the computer system configurations required to use the software.

About this Guide
•The explanations in this guide are based on Windows XP and Mac OS X 

v10.2. If you are using another version of these operating systems, the 
actual screen contents and procedures may vary slightly from those shown.

•This guide uses the following notations on the right to represent the items 
on the left. 
Mac OS X (v10.1/v10.2) -> Mac OS X 
Mac OS 9.0 - 9.2 -> Mac OS 9
CF Card, SD Card, PC Card -> Memory Card



It’s so Simple! Make Prints Right at Home Like a Pro2

It’s so Simple! Make Prints Right at Home 
Like a Pro 

See your Camera User Guide for shooting instructions.

Just install the software once at the beginning.

Shoot the images

Install the software on the 
computer
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Download images to the computer

Print the images

Connect the camera to the computer



Unbounded Possibilities with Entertaining Software4

Unbounded Possibilities with Entertaining 
Software

Print a Variety of Layouts
Print with the diverse layouts available in PhotoRecord (Windows) and 
ImageBrowser (Macintosh). The examples shown are from PhotoRecord 
(Windows).

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch. 

Confirm all your images in one glance with 
index (contact sheet) printing.

Make your own photo 
album of precious 
moments.
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Send an Image as an E-mail Attachment
Attach an image to an e-mail message by starting your mail software from 
within ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer
Release the camera’s shutter from the computer with ZoomBrowser EX 
(Windows) or ImageBrowser (Macintosh). The recorded image is saved directly 
to your computer.

Release the shutter from the computer.
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About the CD-ROMs in Your Package

About the Supplied Software
In addition to the Canon Digital Camera Solution Disk, your camera may be 
accompanied by other CD-ROMs containing image editing software. Your 
choice of camera model will determine which disks are included.

See Information about Your Camera (p. 105) to read which disks are included 
with your model.

See About the CD-ROMs Supplied with the Solution Disk section (p. 88) for 
the installation methods and features of the software contained on the CD-
ROMs other than the Canon Digital Camera Solution Disk. 

Using the PDF Manuals
The following PDF-format manuals (hereafter PDF manuals) are provided 
to explain the features and procedures for using ZoomBrowser EX and 
ImageBrowser.
• ZoomBrowser EX Software User Guide (Windows)
• ImageBrowser Software User Guide (Macintosh)

Adobe Acrobat Reader must be installed to read the 
aforementioned PDF manuals.

Viewing PDF Manuals
Viewing Manuals Downloaded from a Website
These PDF-format manuals are available on the Canon website. Use your 
browser program to download these manuals from the following URL:

http://web.canon.jp/Imaging/information-e.html
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System Requirements

Please install the software on a computer meeting the following minimum 
requirements.

Windows

OS Windows 98 (First or Second Edition)
Windows Millennium Edition (Windows Me)
Windows 2000
Windows XP (Home Edition, Professional)

Computer Model The above OS should be pre-installed on computers with built-
in USB ports.

CPU Windows 98/ Windows Me/ Windows 2000: Pentium 150 MHz 
or higher processor
Windows XP: Pentium 300 MHz or higher processor

RAM Windows 98/ Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ZoomBrowser EX: 200 MB or more 

(Including the PhotoRecord printing program)
- PhotoStitch: 40 MB or more

•Canon Camera TWAIN Driver: 25 MB or more
•Canon Camera WIA Driver: 25 MB or more

Display 800 x 600 pixels/ High Color (16 bit) or better is required
1,024 x 768 pixels or better is recommended

•A CD-ROM drive is required to install the software.   
•A sound card is required to play movie audio tracks.
•All procedures performed with a connection to a USB 2.0 

compliant board are not guaranteed.
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Macintosh

OS Mac OS 9.0 - 9.2, Mac OS X (v10.1/v10.2)

Computer Model The above OS should be pre-installed on computers with built-
in USB ports.

CPU PowerPC

RAM Mac OS 9.0 - 9.2: 64 MB or more of application memory
Mac OS X (v10.1/v10.2): 128 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ImageBrowser: 120 MB or more 
- PhotoStitch: 30 MB or more

Display 800 x 600 pixels/ 32,000 Colors or better is required
1,024 x 768 pixels or better is recommended

•A CD-ROM drive is required to install the software. 
•The supplied application programs are compatible with Mac OS 

X (v10.1/v10.2), but cannot be used on disks formatted with the 
Unix File System (UFS).

• All procedures performed with a connection to a USB 2.0 
compliant board are not guaranteed.
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Using the Software on the Windows 
Platform

- Preparations -

This chapter explains the basic procedures for installing the software and 
connecting the camera to a computer. Read this material before you connect 
the camera to the computer.



Installing the Software and USB Driver10

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

•Your computer
•Canon Digital Camera Solution Disk supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT 
connected to the computer. 
If it is, disconnect the cable. The 
software cannot be properly installed if 
the camera is connected to the 
computer at the start.

2 Close any programs that are running. 

3 Place the Canon Digital Camera Solution 
Disk in the computer’s CD-ROM drive.
The installer panel will display automatically. 

If the installer panel does not appear 
automatically, use the procedures in How to 
Display the Installer Panel on the next page. 

•You must install the software before you connect the camera to 
the computer. 

•Users of Windows XP Professional and Windows 2000 must first 
log in as an Administrator (computer system administrator) to 
install programs. 
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4 Click [Software Installation].

5 Click [Next].
6 Read the software license agreement and click [Yes] if you consent to 

all the conditions.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not 
appear automatically.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe]  icon.

Windows 2000, Windows Me, Windows 98
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe]  icon. 
(Some computers may not display the [.exe] file name extension as 
shown above.) 

Installer Panel
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7 Confirm the installation destination and click [Next].

8 Select the programs you wish to install and click [Next].
Confirm that there is a check mark beside the names of the programs you 
wish to install.

The USB driver (the software for connecting) is required 
when the camera is connected to the computer with a USB 
cable. Ensure that you select a USB driver from below (the 
appropriate one for your operating system). 
• Windows 2000: Canon Camera TWAIN Driver 
• Windows Me: Canon Camera WIA Driver  
• Windows 98: Canon Camera TWAIN Driver

With Windows XP, the USB driver supplied with the Windows 
operating system is used so there is no need to install a USB 
driver.

Installation destination
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9 Review the installation settings and click [Next].

The installation will start. Follow the onscreen instructions to proceed.

10 Click [OK] if the following message appears. 
This message will display if you selected and installed the USB driver in Step 
8.

11 When the installation is over, select [Yes, I want to restart my 
computer now.] and click [Finish].

Users of Windows XP Professional and Windows 2000 must 
log in as an Administrator (computer system administrator) 
after restarting to carry out the subsequent procedures. 

The items displayed here 
differ according to the 
software installed.
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12 Remove the disk from the CD-ROM drive 
when your normal desktop screen appears 
after restarting.
This concludes the software installation. 
Continue by connecting the camera to the 
computer so that the USB driver can be 
utilized.

13 Attach the camera to the computer 
and set it to the correct mode for 
connecting.

The USB driver will automatically finish installing onto the computer when 
you attach the camera and open a connection. Dialogs similar to the 
following ones will appear during this process (first connection only).

Windows XP 
The following dialog will appear after a few moments and the USB driver 
supplied with the Windows operating system will automatically install.

If you installed a USB driver, so far the required files have 
only been copied to your computer. You must now connect 
the camera to the computer with the USB cable to complete 
the installation and prepare the driver for use. 

See Uninstalling the Software (p. 90) to delete the software 
installed with these procedures.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 105) 
for details. 
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Windows 2000/Windows Me/Windows 98 
The "Add New Hardware Wizard" will appear after a few moments and 
the USB driver will automatically install. 

Restart the computer according to the instructions if you are prompted to 
do so by a message.

The Events dialog will appear after installation, allowing you to select an 
application to start. The explanation for these procedures is contained in 
Using the Software on the Windows Platform-The Basics (p. 17).

This concludes the software and USB driver installation and the procedures for 
connecting the camera to the computer.
You may now download camera images to the computer (p. 17). 

The USB driver selected in Step 8 will automatically install. 

•See USB driver installation not proceeding well in the 
Troubleshooting section (p. 96) if you are having problems 
installing the USB driver.

•See Uninstalling the USB Driver (p. 91) to delete the USB 
driver installed with these procedures.

•See If You Were Using ZoomBrowser EX Version 2 or 3
(p. 103) if you were previously using either version. 
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Using the Software on the Windows 
Platform

- The Basics -

This chapter explains the procedures for using ZoomBrowser EX to download 
the camera's images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software 
on the Windows Platform - Preparations - section. 



Downloading Images to the Computer18

Downloading Images to the Computer

Begin by starting up ZoomBrowser EX and downloading images to your 
computer. The startup procedures vary slightly according to whether you are 
connecting the camera to the computer or using a memory card reader. 

Camera to Computer Connection

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital Terminal. Prepare the camera for communication 
with the computer.

•The first time you start ZoomBrowser EX, all the images that 
have not previously been downloaded will download to the 
folder shown in the [Save to] section of the Download image 
window (p. 20). 

•You can change the settings for the images to be downloaded 
and the downloading destination by clicking the [Camera] menu 
in ZoomBrowser EX’s main window and selecting [Auto- 
download setting].

•You can also display an index of the camera or memory card 
images to check them before downloading or download them 
selectively. For instructions, see Checking Images before 
Downloading (p. 32). 

A window stating that the server is busy may display while 
images are downloading. If this happens, wait a moment and 
click the [Retry] button (p. 102).

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 105) 
for details. 
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A dialog (Events dialog) similar to that below will appear after a moment. 
Select the application program you wish to start from the list in this dialog.

If the above dialog (Events dialog) does not appear, start 
ZoomBrowser EX with the procedures described below in If
the Events Dialog Does not Appear.

If the Events Dialog Does not Appear
Perform the following procedures.

1 Double-click the [ZoomBrowser EX] icon on the 
desktop.

2 Click [Camera & Memory 
Card] when ZoomBrowser EX 
starts.

3 Click [Browse & Download 
Images] in the next menu.

Proceed to Step 3 when the 
Download image window 
appears.

Your camera model name 
or "Canon Camera" will 
appear here.

Select an application 
program here.
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2 Select [Canon ZoomBrowser EX] and click [OK]. 

This will display the Download image window.

3 Click [Start download].

The camera images download to the computer. The downloaded images 
are saved into folders according to the shooting date.

A dialog allowing you to select the camera model will 
display if a camera and a memory card reader are connected 
at the same time. Confirm that your model name or "Canon 
Camera" is displayed and click [OK].

Images will be downloaded 
to this folder.
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When downloading is complete, the thumbnails (tiny versions) of the 
downloaded images display in ZoomBrowser EX’s main window. 

Next, print out the images (p. 24). 
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Memory Card Connection

1 Insert the memory card into the reader.
Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling 
instructions.

2 Start ZoomBrowser EX.
Double-click the [ZoomBrowser EX] icon on the desktop.

3 Click [Camera & Memory Card].

4 Click [Browse & Download Images] in the next menu.

Place the memory card in an 
adapter if required.

Insert the loaded adapter 
into the slot.
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The Download image window will appear. 

5 Click [Start Download].

The memory card images download to the computer. The downloaded 
images are saved into folders according to the shooting date.

When the download is complete, the thumbnails (tiny versions) of the 
downloaded images display in ZoomBrowser EX’s main window. 

Next, print out the images (p. 24). 

A selection dialog will appear if multiple memory card 
readers loaded with memory cards are connected or if a 
camera and memory card reader are connected. Select one 
device and click [OK].

See Memory Card Folder Structure (p. 94) for information 
about memory card folder structures and file names.

Images will be downloaded 

to this folder.
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Printing Images

You will use a program called PhotoRecord to print images. This section explains 
the basic procedures for PhotoRecord. See the program’s [Help] menu for more 
details.

1 Click [Print] in the main window.

2 Click [Layout Print] in the next menu.

3 Click on the image(s) you wish to print and click the [Next] button at 
the window's bottom right. 

Movies cannot be printed.

The background color of the selected images 
will change to orange.
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4 Place a check mark beside the data you wish to include with the print 
(multiple selections are possible) and click [Finish].

The PhotoRecord printing utility will start, displaying the selected image 
and the information selected in Step 4 in the Album window. In addition, 
the steps that will take you through the printing process will display on the 
left side. Follow the steps in order to proceed. 

To add a comment to an image, select it in ZoomBrowser EX 
and click [Properties].

If the PhotoRecord tutorial window displays, use the arrows 
at the window’s bottom right to control it. 

For example, you can print 
the shooting date and time 
with the image if you select 
[Date and Time] here.

Album Window
The selected 
images display 
here.

The printing procedures display here.
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5 Click [2 Select Printer & Album Type] and select a printer and album 
type.

6 Click [3 Select paper] and select the paper size and orientation.

•You can select either the [Booklet] or [Simple Album] option 
for the [Album] category in the [Album Type] section. By 
selecting [Booklet], you can create a margin at the left side 
so the images can be kept in an album. Selecting [Simple 
Album] creates equal margins on both sides. To adjust the 
margin, click [Margins] and change the value.

•In the [Others] category of the [Album Type] section, you 
can choose options such as printing one image per page or a 
contact sheet.

Select the printer.

Select the album type.

Set the paper size and orientation.
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7 Click [Decorate Album] and change the design of the image 
background and border as required. 

8 Click [4 Print], confirm the number of copies and other printing 
settings, and click [Print]. 

Printing will commence.

•The [Themes] category provides consistent designs for use 
throughout an entire album. Selecting a theme 
automatically sets the background, image border and text 
border for all images.

•You can also click [Add Titles & Captions] to add text as a 
title or caption. 

Click the [Themes], [Backgrounds], [Photo Frames], [Text Frames] or 
[Clipart] button to switch between selections.

Perform the procedures according to the instructions 
beside the  symbol. 
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9 Click  to close PhotoRecord. 
A message will display asking you whether or not save the album layout. 
Select [Yes] to save it or [No] to cancel it.

The ZoomBrowser EX screen will reappear after the file processing is 
complete. This concludes the printing process.

This chapter explained the ZoomBrowser EX basics. Once you have 
mastered them, read the following chapter to try the advanced techniques.
Using the Software on the Windows Platform - Advanced Techniques
(p. 29). 

Printing One Image Per Page 
In Step 5, select the [Other] category in the [Album Type] section, 
followed by [One Photo Per Page]. 

Printing a Contact Sheet
To print a contact sheet, select [Contact Sheet Print] in Step 2. After 
Steps 3 and 4, the PhotoRecord printing utility will start. You can print 
image thumbnails and shooting data by setting the number of rows and 
columns per page, the Exif data* (shooting information) display size and 
paper size, and then clicking [Print].
* There is a difference between the shooting information shown in 

ZoomBrowser EX and the Exif information that can be printed with 
PhotoRecord.

•With images shot by Exif 2.2 (called Exif Print) compatible 
cameras, shooting information such as the shooting settings 
and mode can be included with the images. You can use this 
data to correct and print the images to obtain enhanced 
results. Under the default setting, image correction is 
automatically carried out. See the PhotoRecord Help menu 
if you do not require image correction. 

•PhotoRecord automatically carries out image correction (as 
a default setting) with both images shot with Exif 2.2 
compatible cameras and other images, yielding high-quality 
prints.

•A PDF-format manual for ZoomBrowser EX is also available. 
It provides further information about the program's 
features and procedures. See Using the PDF Manuals (p. 6).
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Using the Software on the Windows 
Platform

- Advanced Techniques -

This chapter explains various ZoomBrowser EX features, such as how to play 
movies and create panoramic images.

Proceed to this chapter once you have mastered the basic ZoomBrowser EX 
procedures in the Using the Software on the Windows Platform - The Basics
chapter.
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The ZoomBrowser EX Windows

ZoomBrowser EX has two windows: the Main Window and the Camera 
Window. This topic explains the features of these two windows. 

Main Window

This window can be used to organize the images downloaded to the computer. 
It can also be used for other purposes, such as printing images and attaching 
them to e-mail messages.

You can change the zoom speed for images displayed in the 
Browser Area. Click the [Tools] menu, select [Preferences] and 
slide the [Zooming] lever.

Folders Area
Select image folders here. As in Windows 
Explorer, you can view the contents of 
the folders.

Task Buttons
These buttons select 
the task to carry out.

Browser Area 
Displays the images contained in the 
folder selected in the Folders area. 
Double-clicking an image shows it at a 
larger size.

Function Buttons
These buttons apply functions to 
images selected in the Browser 
Area.
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Camera Window

This window can be used to view images in the camera (or memory card) and 
download the images to the computer as you confirm them. 

ZoomBrowser EX comes with a function that rotates, downloads 
and displays images, shot vertically or horizontally, in their 
correct viewing orientation. (Rotating images does not affect 
image quality)
Only the rotated image is saved to the computer with the 
following camera and image settings.
•When JPEG images are shot with the camera's [Auto Rotate] 

function set to [On].
•When JPEG images are rotated with the camera’s manual 

rotation settings.
•When JPEG images are rotated in the Camera Window.
To download both the pre-rotation and post-rotation images, 
click the [Tools] menu in ZoomBrowser EX's main window and 
select [Preferences], followed by the [Rotation] tab. Place a check 
mark beside [Rotate a copy of the JPEG image].

The images from the camera (or 
memory card) display here.

Function Buttons
These buttons apply functions to images 
selected in the Camera Window.

Task Buttons
These buttons 
select the task 
to carry out.

A window allowing you to specify the download 
destination opens when you select images and 
click the [Download image] button.
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Checking Images before Downloading

You can check camera or memory card images in the Camera Window before 
processing them. You can also choose to download only the images you select 
in the Camera Window. 

1 Display the Download image window. 
To download images from a camera, follow Steps 1-2 in the Camera to 
Computer Connection section (p. 18). 
To download images from a memory card, follow Steps 1-4 in the Memory 
Card Connection section (p. 22). 

2 Click [Browse Images].

The Camera Window will display. 
This window shows thumbnails (tiny versions) of the camera or memory card 
images.

Thumbnail

The movie icon displays on 
movie thumbnails.
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3 Click on images in the Camera Window that you wish to download. 
The background color of the selected images will change to orange.

4 Click [Download image].

A Download Settings dialog allowing you to select the image destination 
folder will display.

5 Confirm the destination folder and click [OK].

If you are downloading images previously selected with the 
camera’s [Transfer Order] setting, click [Select] and select 
[Select Send mark].

Specify the destination folder 
for the image(s).
(You can change the destination 
folder by clicking [Browse] and 
selecting a new destination.)

Select [Create new folder] to 
create a new folder within the 
one specified above, and select 
a naming option.
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At this point the Camera Window will close and the main window will 
open. The downloaded images will appear in the main window.

Other Methods of Downloading Images to the Computer
* Windows XP 
Your camera uses a standard image transfer protocol called the Picture 
Transfer Protocol (PTP). With the PTP and Windows XP, all you need do is 
connect the camera to the computer with a USB cable to download images. 
It is easy using the Scanners and Cameras Wizard and other procedures. (You 
do not even need to install ZoomBrowser EX or the USB driver.) However, 
there are some inconveniences and limitations to this downloading method. 
See the For Windows® XP and Mac OS X Users leaflet for details. 

* Windows Me (with the USB driver installed)
It is easy to download images using the Scanners and Cameras Wizard or 
Windows Explorer. All you need do is connect the camera to the computer 
with a USB cable. (ZoomBrowser EX does not need to be installed.) However, 
you cannot download movies with this method. 

See the Windows Help system for information about the Scanners and 
Cameras Wizard and Windows Explorer. 

Main Window
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Replaying Movies

When you double-click an image with a movie icon in the ZoomBrowser EX’s 
Browser Area, QuickTime Player will start and replay the movie. 

1 Double-click an image with a movie icon. 
QuickTime Player will start. 

2 Click the play button  in QuickTime 
Player.
The movie will replay.

Do not double-click a movie file (.AVI extension) in the Windows 
Explorer to play it. That will start Windows Media Player, which 
may not support this file type. To replay movies, start QuickTime 
Player through the [Start] menu and open the file using the 
QuickTime Player [File] menu.

Installation Procedures for QuickTime
1. Set the Canon Digital Camera Solution Disk in the CD-ROM drive.

The installer panel will automatically appear. (Display it with the 
procedures in How to Display the Installer Panel (p. 11) if it does not 
appear.)

2 Click [QuickTime 5.0 Installation].

Follow the onscreen instructions to proceed with the installation.
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Searching Images

You can search for images marked as your Favorites or by such parameters as 
the modification date, shooting date or keywords. The procedures for marking 
images as Favorites and adding keywords to them are explained in the following 
pages. 

1 Select a folder to search in the Browser Area. 

2 Click [View & Modify], followed by [Search] in the next menu. 

3 Set the search parameters.
Place a check mark in the parameter you wish to use. 
If you selected the modification or shooting date, set the date range. If you 
selected the keyword option, select the keywords.

Set the parameters 
here. 

Sets whether 
images are 
searched 
according to all the 
parameters or just 
one.

Clicking here allows you to hide the 
search parameter details.
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4 Click [Next] after setting the search parameters. 
The images satisfying the parameters will be displayed.

5 If the search results are satisfactory, click the [Finish] button. 
To change the parameters and execute another search, click [Back] and 
repeat steps 3-4. 

This concludes the search process. 
A new folder called the Search Results folder will be created in the main 
window and will contain the images that met the search criteria. Images in 
this folder can be selected, printed and saved to another folder. The images 
will display in this folder until ZoomBrowser EX is closed or another search 
is performed.

Setting Image Parameters for Future Searches

Placing a Check Mark in the Favorites Box
Adding a check mark to the Favorites box makes it easy to perform searches on 
images later.

1 Select the image in the Browser Area and click  (Properties).

The Properties window will display. 

2 Click the [Favorite Photo] box to add a 
check mark and close the Properties 
window. 

Images satisfying 
the search 
parameters

Folder containing the images satisfying the 
search parameters
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This concludes the process for marking an image as one of your favorites. 
The symbol shown below is displayed on images marked as your favorites. 

Adding Keywords to Images
Add searchable keywords to images. 

1 Select the image in the Browser Area and click  (Properties).
2 Click [View/Modify Keywords].

3 To add an existing keyword to an image, click the keyword to add a 
check mark beside it.

4 Click [OK].

This completes the procedures for adding keywords to images.

Favorites Symbol

Select an existing keyword to 
add to an image.

To add a new keyword, type the 
new word in the box to the left 
and click the [+] button.
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Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a 
connected camera. This is particularly useful for checking images on the larger 
display of the computer as you record them and for high volume photography 
without worrying about filling the camera’s memory card.

Preparing for Remote Shooting

1 Ensure that the camera is connected to the computer and that 
ZoomBrowser EX is displaying its main window.

2 Open the lens cover or remove the lens cap on models equipped 
with them. Proceed to the next step if your model does not have 
one. 

3 Click [Cancel] if the Events dialog appears.

4 Click [Camera & Memory Card], then [Remote Shooting] in the next 
menu. 
The RemoteCapture Task window will appear.

See Information about Your Camera (p. 105) to see whether your 
camera model is compatible with this feature.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 105) 
for details.



Operating the Shutter Remotely40

RemoteCapture Task Window 

The RemoteCapture Task window has the following features.

•The settings available in the RemoteCapture Task window vary 
between camera models. 

•RemoteCapture Task locks the exposure and focus settings for 
the subject matter in the Viewfinder section. If the lighting or 
distance to the subject changes, click  to reset these 
settings.

Size and Resolution Selector
Selects the size and resolution at which images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the basic camera settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or detailed 
settings area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click the  icon if the image does not appear in the viewfinder at 
the window. Use the viewfinder to confirm the image.

2 Change the image size or resolution, the rotation settings and the 
settings at the bottom of the window as required. 
If you are tilting the camera 90º on end to capture tall subjects, such as 
people, set the [Rotation Settings] category to [90º-L] or [90º-R] so the 
image appears with the correct orientation in the computer display. 

3 Click the [Release] button.
The image will record.
The recorded image is saved to the folder that was displayed in the window 
when the remote shooting procedures were initiated.

Ensure that you turn off your computer’s standby mode before 
you begin remote shooting. The device performance cannot be 
guaranteed if the computer enters the standby mode.

If your camera is equipped with the Auto Rotate function 
and you set it to On, the image will automatically be rotated 
and appear in the correct viewing orientation in the 
RemoteCapture Task window.

•You can release the shutter by pressing the camera’s shutter 
button or the keyboard’s space key.

•The zoom controls and other camera buttons and switches, 
except for the shutter button, cannot be operated while the 
camera is being used for remote shooting.

•You may notice that the interval between the shutter 
release and activation is slightly longer for remote shooting 
than when the camera is used independently. 
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Interval Timer Shooting

Interval timer shooting is a method of shooting that records a specified number 
of frames at set intervals. 

1 Click the [Shooting] menu in the RemoteCapture Task window and 
select [Interval Timer Shooting].

2 Click [OK] in the confirmation dialog. 
The Interval Timer Shooting window will display.

3 Set the number of frames and the interval value and click [Start]. 
This will record the specified number of frames at the specified interval.

4 Click [OK] in the confirmation dialog.

Timer Shooting

Timer shooting is a method of shooting that records a frame after a specified 
number of seconds.

1 Click the [Shooting] menu in the RemoteCapture Task window and 
select [Timer Shooting].
The Timer Shooting window will display. 

2 Set the timer interval and click [OK]. 
This will record an image after the specified time has elapsed.

You can set the time interval between 5 seconds to 60 
minutes. 

Please note that the camera will not be able to shoot at the 
specified interval if it is shorter than the time required to 
transmit the data and save it to the computer.

You can specify a timer interval from 2 to 30 seconds.
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Other Features 

Changing the File Saving Method
1 Click the [File] menu in the RemoteCapture Task window and select 

[Preferences].
This will display the Preferences dialog.

2 Select a file settings option and click [OK]. 

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor. 

1 Click the [Camera] menu in the RemoteCapture Task window and 
select [Camera Display Settings].
The Camera Display Settings dialog will display.

2 Select [Camera LCD monitor] and click [OK]. 
3 Click the  icon in the RemoteCapture Task window. 

Selecting [Computer only] in the "Save Images On" category 
allows you to shoot when there is no memory card in the 
camera or when the camera's memory card is full.

You can display the subject on a TV connected to the camera 
by selecting [Video Out terminal] in Step 2. See the Camera 
User Guide for instructions to connect the camera to a TV.

Sets whether images are saved only to the 
computer or to both the computer and the 
memory card in the camera.

Input a root name for the image files here. If 
you input “Capture”, for example, the first 
image will be named [Capture_00001.jpg] 
and successive images will automatically be 
assigned a name that is one number higher 
than the last. 

The recorded images are saved to this folder. 
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Merging Panoramic Images - PhotoStitch 

You can create a wide panoramic image by merging several images, such as 
those shot in the camera's Stitch Assist mode.
Use the PhotoStitch program to merge the images.

Starting PhotoStitch 

Start PhotoStitch from ZoomBrowser EX.

1 Click [View & Modify] in the ZoomBrowser EX’s main window and 
[Stitch Photos] in the next menu.  

2 Select a series of images in the Browser Area and click [Finish].
A window similar to that below will appear.

3 Merge the images following the instructions in the guidance panel 
at the top of the PhotoStitch window.

•QuickTime 3.0 or a later version is required to save the 
merged image in the QuickTime VR format. (QuickTime is 
supplied on the Canon Digital Camera Solution Disk.)

•Images shot in Stitch Assist mode with a wide converter, 
teleconverter or close-up lens cannot be merged accurately. 

Follow the instructions 
to merge the images.
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Images Shot in Stitch Assist Mode 

It is easy to merge images shot with the camera's Stitch Assist mode since 
PhotoStitch automatically arranges them in the correct order and orientation.
Stitch Assist mode images appear in the Camera Window as shown below. 

•You can start PhotoStitch by clicking the mark shown on images 
shot in Stitch Assist mode.

•See the Camera User Guide for information about shooting in 
Stitch Assist mode.

Images shot in Stitch Assist mode display a mark 
like this. 
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Saving Images on CD-R/RW Disks 
(Windows XP Only)

You can copy and save ZoomBrowser EX images to CD-R/RW disks. The 
shooting information is copied along with the images. 

1 Place a CD-R/RW disk in the drive.
2 Click [Cancel] to close it if a dialog like that below appears. 

3 Click [View & Modify] in the ZoomBrowser EX main window and 
[Backup to CD] in the next menu.

4 Follow the instructions at the left of the display to proceed. 
The disk will automatically eject from the drive once the files have been 
copied to it. 

This feature is only possible on computers that satisfy the 
following requirements. 

•Windows XP was pre-installed on the computer
•The CD-R/RW drive came as standard equipment with the 

computer

Additional images can be copied onto a CD-R/RW disk with 
sufficient space that has already been written to once. 
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Enjoy Customizing Your Camera with the 
My Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-
timer sound are called the My Camera Settings. You can add your favorite 
images and sounds from your computer to the My Camera Settings. This topic 
explains how to upload the My Camera Settings saved onto your computer to 
the camera and vice versa. Use ZoomBrowser EX to perform this function.

Displaying the My Camera Window

To save the My Camera Settings to the camera, you use the My Camera 
window. The following explains the procedures for displaying the My Camera 
window. 

1 Connect the camera to the computer and start ZoomBrowser EX.
2 Click the [Camera] menu in the main window and select [My Camera 

Settings].
You can also display the My Camera window by clicking the [Set] button in 
the Camera Window and selecting [My Camera] in the next menu.

This will display the My Camera window.

ZoomBrowser EX already contains several pre-recorded My 
Camera Settings items. You can check these items with the 
My Camera window.
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The My Camera Window Features

You can add new data to the My Camera window. See Adding
New Data to the My Camera Window (p. 51). 

Tabs 
Click here to switch between adjusting the 
settings individually or in themed sets. If the 
[Set individually] tab is selected, the Data 
Type can also be selected.

Displays the list of My 
Camera Settings files 
saved onto the 
computer.

Add File Button
Click here to add a file 
as one of the My 
Camera Settings to 
the My Computer list.

Play Button
Click here to play the 
selected sound 
setting.

Delete Button
Click here to delete a 
setting from the My 
Computer list. 

Delete Button
Deletes a setting 
from the Camera 
list.

Displays the My 
Camera Settings 
in the camera.

Play Button 
Click here to play sounds recorded 
onto the camera. 
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Saving the My Camera Settings to the Camera

You can save the My Camera Settings displayed in the My Camera window to 
the camera. 

1 Confirm that the [Setup as a theme] tab is selected in the My Camera 
window. 
To save the settings individually, select the [Set individually] tab and select 
the setting type in the [Data Type] list box. 

2 Select the settings file you wish to save to the camera from the My 
Computer list.
If you are working in the [Setup as a theme] tab, the thumbnail (tiny 
version) of the start-up image will display to the right and the sound files 
will play in the order of start-up sound, shutter sound, operation sound and 
self-timer sound. 

3 Select the setting from the Camera list that you would like to change 
and click [Save to Camera].
This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this 
category has previously been saved to the camera, it will be overwritten. 

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound 
settings on the camera itself. Please see the Camera User Guide for these 
instructions.

•My Camera Settings can be selected and saved in either of two 
ways to the camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the 
start-up image and animal calls in each of the sound files. The 
names of the prepared files for the various My Camera Settings 
themes all begin with the same root name, such as “Animal~”. 
For example, the start-up image that starts with “Animal~” 
shows an animal picture while the similarly named sound files 
feature animal sounds.

•Settings that do not appear in the My Computer list of the My 
Camera window cannot be saved to the camera. 

•Do not detach the USB cable, turn the camera power off or 
disconnect the camera from the computer while the My Camera 
Settings are being saved to the camera or the settings from the 
camera are being saved to the computer. 



Enjoy Customizing Your Camera with the My Camera Settings50

Saving the Camera’s My Camera Settings to the Computer

The My Camera Settings on the camera can be saved to the computer. 

1 Confirm that the [Setup as a theme] tab is selected in the My Camera 
window. 
To save the settings individually, select the [Set individually] tab and select 
the setting type in the [Data Type] list box. 

2 Select the settings file(s) from the Camera list that you wish to save 
to the computer.
If you are working in the [Setup as a theme] tab, the thumbnail (tiny 
version) of the start-up image will display to the right and the sound files 
will play in the order of start-up sound, shutter sound, operation sound and 
self-timer sound. 

3 Click [Save to PC].
4 Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the 
computer.
Repeat steps 1-3 as required.

My Camera Settings can be selected and saved in either of two 
ways to the computer: individually or in theme sets.
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Adding New Data to the My Camera Window

To add new data to the My Camera window, you need to create it, save it to the 
computer and add that file to the My Camera window.

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will 
become the start-up image and save it to the computer. Create the file in the 
JPEG format at a size of (w) 320 x (h) 240 pixels.
Once you have created the data and saved it to the computer, use the following 
procedures to add it to the My Camera window.

1 Open the My Camera window, click the [Set individually] tab, select 
[Startup Image] from [Data Type] and click the [Add File] button.

This will display a dialog for opening files.

2 Select the file you created and click [Open].
The selected file will appear in the Computer list.
This concludes the process for adding new data.
You can save the newly created data to the camera using the procedures 
described in the Saving the My Camera Settings to the Camera section 
(p. 49).

To delete a setting, select the file name and click the [Delete] 
button at the bottom of the My Computer list.
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Create an Original Sound File and then Add It
The following example shows how to record and create a start-up sound file 
using the My Camera Sound Maker window.
QuickTime is required to play the recorded sound.

1 Click the [Camera] menu in the ZoomBrowser EX main window and 
select [Create a My Camera Sound]. 
The My Camera Sound Maker window will display.

2 Click the tab of the sound file you will be creating, followed by the 
[Record] button. Click the [Start_up Sound] tab in this example.

3 Click the [Start] button.

Recording will start.

To open a sound file already saved to the computer, click the 
[Open] button in place of the [Record] button. Then skip to 
Step 6.
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4 When the recording is complete, click the [Stop] button, followed by 
the [Close] button.
Recording will stop after 30 seconds elapses even if the Stop button is not 
clicked. In that case, just click the [Close] button. 
The following window will appear. 

5 Click the [Sound Format] button as required and select a sound 
format.

6 Edit the sound data so that it conforms to the time limits. 
Adjust the time of the recording with the blue or red switch. 
The extra data outside the starting and finishing switches can be erased by 
clicking the [Cut] button.

7 Click the [Save] tab, confirm that the sound file was created, input a 
file name and then save it. 

8 Click the [Save] button, add a file name and save it.

9 Click  to close the My Camera Sound Maker window. 
This concludes the process of adding a sound file as a My Camera settings 
file to the computer.

Repeats steps 2-8 as required to create sound files for the 
shutter sound, operation sound and self-timer sound. 

Volume Control

Starting position of 
sound (blue switch).

Play Stop Rewind

Finishing 
position of 
sound (red 
switch)
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You can add the file to the camera with the procedures described in the 
Saving the  My Camera Settings to the Camera section (p. 49).

•To delete a setting, select the file name and click the [Delete] 
button at the bottom of the My Computer list. 

•Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono 
sound in the WAV format. The following chart shows 
standard time lengths for My Camera Sounds.

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less



M
acintosh - P

rep
a

ra
tio

n
s -

55

Using the Software on the 
Macintosh Platform

- Preparations -

This chapter explains the basic procedures for installing the software. Read this 
material before you connect the camera to the computer for the first time.
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Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare

•Your computer
•Canon Digital Camera Solution Disk supplied with the camera

Installation Procedures

1 Close any programs that are running. 
2 Place the Canon Digital Camera Solution 

Disk in the computer’s CD-ROM drive.

3 Double-click the CD-ROM icon, followed by 
the [Mac OS X] and [Canon Digital Camera 

Installer]  icons.
With Mac OS 9, double-click the CD-ROM icon, 
followed by the [Mac OS 9] and [Canon Digital 

Camera Installer]  icons.
The installer panel will display automatically.

4 Click [Digital Camera Software Installation]. 

This will start the installation.
Follow the onscreen instructions to proceed with the installation.

Installer Panel
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5 Remove the disk from the CD-ROM drive when 
the installation is complete. 

This concludes the software installation. 
Continue by downloading images to the computer (p. 67). 

See Uninstalling the Software (p. 93) to delete the software 
installed with these procedures.
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Using the Software on the 
Macintosh Platform

- The Basics -

This chapter explains the procedures for using ImageBrowser to download the 
camera's images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software 
on the Macintosh Platform - Preparations - section. 
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Starting ImageBrowser

Begin by starting up ImageBrowser. The startup procedures vary according to 
whether you are connecting the camera to the computer or using a memory 
card reader. 

Camera to Computer Connection

Mac OS X
1 Attach the supplied USB cable to the computer’s USB port and the 

camera’s Digital Terminal. Prepare the camera for communication 
with the computer. 

iPhoto or Image Capture will automatically start when the camera and 
computer are ready to connect. If either of these programs does not start, 
proceed to Step 3.

2 Click  at the upper left of the iPhoto or Image Capture window to 
close it.

3 Double-click the [Canon ImageBrowser] icon on the 
desktop. 
If the Canon ImageBrowser icon does not appear on the 
desktop, double-click the [Canon Utilities] folder on the 
drive on which the program was installed, followed by the [ImageBrowser] 
folder and [ImageBrowser] icon.

4 Click [Canon Camera] in the Explorer View section.

The Communication Settings dialog will display.
This dialog will only appear for the first connection.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 105) 
for details. 

Explorer View Section
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5 Confirm that [USB port] is selected as the port option and that your 
camera model name or [Canon Camera] are selected as the detected 
camera. Click [Set]. 

iPhoto or Image Capture may automatically start up at the same time as the 
Camera Window. Step 6 is not required when neither program starts up 
automatically. 

6 Click the  icon at the top left of the iPhoto or Image Capture 
window to close the program. 

7 Confirm that the images from the camera are displayed as 
thumbnails (tiny versions) in the Camera Window.

Your camera model 
name or [Canon Camera] 
and the USB port 
number (e.g. @1) will 
appear here.

Thumbnail

Camera Window
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Mac OS 9
1 Attach the supplied USB cable to the computer’s USB port and the 

camera’s Digital Terminal. Prepare the camera for communication 
with the computer.

How to Set ImageBrowser to Start Automatically with Mac 
OS X 
You can have ImageBrowser start automatically when you connect the 
camera to the computer by adjusting the following settings.
Mac OS X v10.2
1. Start Image Capture, click the [Image Capture] menu and select 

[Preferences].
2. In the next menu, click the [Camera Preferences] list box and select 

[Other]. 

3. Select [ImageBrowser] in the program selection window.
4. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.
Mac OS X v10.1
1. Start Image Capture and select [Other] from the Hot Plug Action list 

box.

2. Select [ImageBrowser] in the program selection window.
3. Close Image Capture.
ImageBrowser will start automatically from the next connection onward.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 105) 
for details. 
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ImageBrowser will start and open the ImageBrowser Automation Wizard 
dialog. 

2 Confirm that [Display Images] is selected and click the [OK] button.

The Communication Settings dialog will display.
This dialog only appears the first time the camera is connected.

3 Confirm that [USB port] is selected as the port option and that your 
camera model name or [Canon Camera] are selected as the detected 
camera. Click [Set].

The Camera Window will open and display the camera’s images as 
thumbnails (tiny versions). 

In the ImageBrowser Automation Wizard dialog, you can 
select the action that is carried out after ImageBrowser 
starts.

Confirm that this 
option is selected.

Your camera model name 
or [Canon Camera] will 
appear here.
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Next, download images to the computer (p. 67).

What to Do the Next Time ImageBrowser is Started 
A dialog with the previously selected automated settings will display the 
next time you start ImageBrowser. To use these settings unchanged, 
click the [Start] button. To do nothing, click [Cancel]. To change the 
settings, click [Settings change].

How to Set ImageBrowser to Not Start Automatically
1. Click the Apple menu  and select [Control Panels] and [Canon 

ImageBrowser Auto Launch].
The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the check 
mark.

3. Click the close box  at the upper left to close the window.

To change the settings, click [Settings Change] and select the desired action in 
the ImageBrowser Automation Wizard dialog.

Click here to close the window.

Clear the check mark here to 
stop ImageBrowser from 
starting automatically.
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Memory Card Connection

1 Insert the memory card into the reader.
Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card for its connection and handling 
instructions.

2 Start ImageBrowser.
Double-click the [Canon ImageBrowser] icon on the desktop.

If the icon does not appear on the desktop, double-click the folder in which 
you installed the program, followed by the [Canon Utilities] and 
[ImageBrowser] folders and the [ImageBrowser] file.

3 Double-click the [DCIM] folder in the Explorer View Section.

Place the memory card in an 
adapter if required.

Insert the loaded adapter 
into the slot.

Mac OS X Mac OS 9

Explorer View 
Section
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The images from the memory card will display as thumbnails (tiny versions) 
in the Camera Window. 

Next, download images to the computer (p. 67).

See Memory Card Folder Structure (p. 94) for information 
about memory card folder structures and file names.
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Downloading Images to the Computer

Creating a Folder to Receive Downloaded Images 

Create a new folder for downloaded images with the following procedures.

1 Click the window labeled [Browser Window] and bring it to the 
foreground.

2 Select the [Users] folder and the subfolder labeled with your user 
name on the startup disk. 
Mac OS 9 users should select [Macintosh HD] in the Explorer View section. 

3 Click the [File] menu and select [New Folder]. 

This will create a folder labeled “Untitled.”

4 Input a new name and press the [return] key.
This will replace the name with the one you type.

Explorer View Section
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5 Select the newly created folder.

Downloading Images

Download images to the new folder.

1 Click the Camera Window to bring it to the forefront.
2 Click the images to download.

A blue frame appears around selected images.

You can select multiple images by holding the [shift] key 
while clicking images.

Thumbnail

The movie icon displays on 
movie thumbnails.
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3 Click [Download].

The downloaded images will copy to the computer and appear in the 
Browser Area.

Continue by printing out an image (p. 70).

•You can also download images to the computer by dragging 
them from the Camera Window and dropping them on the 
Browser Area or the Explorer View Section.

•To close the connection to the camera, click the close box  
(Mac OS 9) or the red close box  (Mac OS X) at the top left 
of the Camera Window.

•Your camera uses a standard image transfer protocol called 
the Picture Transfer Protocol (PTP). With the PTP protocol 
and Mac OS X, you can easily download images by 
connecting the camera to the computer with a USB cable 
and using the software preinstalled on your operating 
system, such as iPhoto and Image Capture. (You do not even 
need to install ImageBrowser.) However, there are some 
inconveniences and limitations to this downloading 
method. See the For Windows® XP and Mac OS X Users
leaflet for details. 

The movie icon 
displays on movie 
thumbnails.

Browser Area
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Printing Images

Printing

1 Select the image(s) you wish to print.
A blue frame appears around selected images.

2 Click the [Print] button and select [Layout printing] from the 
displayed menu.

This displays the Layout Options dialog and the Print window.

3 Confirm that [Custom layout printing] is selected and click [Next].

Movie images cannot be printed. 

Layout Options dialog

Print window
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4 Select settings, such as the paper size, and click [OK].
This will close the Layout Options dialog and allow you to change the 
layout and print settings in the Print window.

5 Adjust the page layout in the Print window if you wish.
See Print Window Features (p. 72) for information about changing layouts.

6 Click the [Print] button in the Print window.
This will display the Print dialog.

7 Click [OK] to start printing.

This concludes the image printing process.

•Selecting the [Custom layout printing] option allows you to 
freely specify the image size and position for printing.

•Selecting an alternative option allows you to print the 
images in an index or in a tiled arrangement.
The [Canon perforated paper printing] option can be 
selected with Mac OS 9.

The settings available in Step 4 will vary according to the 
type of layout selected in Step 3. 

•You can start an index print by selecting [Index printing] in 
Step 2.

•Images shot with Exif 2.2-compliant cameras (Exif Print) 
incorporate information about the shooting settings, such 
as the camera modes and settings. Better prints can be 
made by using this information to correct the image. You 
can set this function by clicking the [ImageBrowser] menu 
and selecting [Preferences] (in Mac OS 9, click the [Edit] 
menu to select [Preferences]), followed by [Print] in the list 
box and [Image Correction Settings]. 
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Print Window Features

When the [Custom layout printing] option is selected in the Layout Options 
window, you can freely change the size and position of the images for printing.

This chapter explained the ImageBrowser basics. Once you have mastered 
them, read the following chapter to try the advanced techniques.
Using the Software on the Macintosh Platform - Advanced Techniques -
(p. 73). 

A PDF-format manual for ImageBrowser is also available. It 
provides further information about the program's features 
and procedures. See Using the PDF Manuals (p. 6).

Change the Image Size
Drag the border to 
resize the image. 

Change the default 
number of images 
printed per page.

Rotate the selected 
image. 

Vertically and 
horizontally lines up 
images in the 
window.

Edit the Page Title
Open the [Edit] menu 
and select [Edit 
Header].

Change the Layout
Drag the images to 
change the layout.

Add Text
Open the [Edit] menu 
and select [Add Text].

Add Captions to Images
Click the image and 
then the [Edit] menu 
and select [Edit 
Caption].

Displays the Layout 
Options window.

Displays the Print dialog.
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Using the Software on the 
Macintosh Platform

- Advanced Techniques -

This chapter explains how to use various ImageBrowser features, such as how to 
play movies and create panoramic images.

Proceed to this chapter once you have mastered the basic ImageBrowser 
procedures in the Using the Software on the Macintosh Platform - The Basics -
chapter.
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Replaying Movies

When you double-click an image with a movie icon in the ImageBrowser’s 
Browser Area, QuickTime Player will start and replay the movie. 

1 Double-click an image with a movie icon. 
QuickTime Player will start. 

2 Click the play button  in QuickTime Player.
The movie will replay.
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Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a 
connected camera. This is particularly useful for checking images on the larger 
display of the computer as you record them and for high volume photography 
without worrying about filling the camera’s memory card.

Preparing for Remote Shooting

1 Ensure that the camera is connected to the computer and that 
ImageBrowser is displaying its Browser Window.
Close the Camera Window if it appears.

2 Open the lens cover or remove the lens cap on models equipped 
with them. Proceed to the next step if your model does not have 
one. 

3 Click the [Edit] menu and select [RemoteCapture].
The RemoteCapture Task window will appear.

See Information about Your Camera (p. 105) to see whether your 
camera model is compatible with this feature.

Procedures for attaching the camera to the computer and 
placing it in the correct mode for connecting vary between 
camera models. See Information about Your Camera (p. 105) 
for details.
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RemoteCapture Task Window 

The RemoteCapture Task window has the following features.

•The settings available in the RemoteCapture Task window vary 
between camera models. 

•RemoteCapture Task locks the exposure and focus settings for 
the subject matter in the Viewfinder section. If the lighting or 
distance to the subject changes, click  to reset these settings.

Size and Resolution Selector
Selects the size and resolution at which 
images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the basic camera settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or 
detailed settings 
area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click the  icon if the image does not appear in the viewfinder 
at  the window. Use the viewfinder to confirm the image.

2 Change the image size or resolution, the rotation settings and the 
settings at the bottom of the window as required. 
If you are tilting the camera 90º on end to capture tall subjects, such as 
people, set the [Rotation Settings] category to [90º-L] or [90º-R] so the 
image appears with the correct orientation in the computer display. 

3 Click the [Release] button.
The image will record.
The recorded image is saved to the folder that was displayed in the window 
when the remote shooting procedures were initiated.

Ensure that you turn off your computer’s sleep mode before you 
begin remote shooting. The device performance cannot be 
guaranteed if the computer enters the sleep mode.

If your camera is equipped with the Auto Rotate function 
and you set it to On, the image will automatically be rotated 
and appear in the correct viewing orientation in the 
RemoteCapture Task window.

•You can release the shutter by pressing the camera’s shutter 
button or the keyboard’s space key.

•The zoom controls and other camera buttons and switches, 
except for the shutter button, cannot be operated while the 
camera is being used for remote shooting.

•You may notice that the interval between the shutter 
release and activation is slightly longer for remote shooting 
than when the camera is used independently. 
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Interval Timer Shooting

Interval timer shooting is a method of shooting that records a specified number 
of frames at set intervals. 

1 Click the [Edit] menu in the RemoteCapture Task window and select 
[Interval Timer Shooting].

2 Click [OK] in the confirmation dialog. 
The Interval Timer Shooting window will display.

3 Set the number of frames and the interval value and click [Start]. 
This will record the specified number of frames at the specified interval.

4 Click [OK] in the confirmation dialog. 

Timer Shooting

Timer shooting is a method of shooting that records a frame after a specified 
number of seconds.

1 Click the [Edit] menu and select [Timer Shooting].
The Timer Shooting window will display. 

2 Set the timer interval and click [Start]. 
This will record an image after the specified time has elapsed.

You can set the time interval between 5 seconds to 60 
minutes. 

Please note that the camera will not be able to shoot at the 
specified interval if it is shorter than the time required to 
transmit the data and save it to the computer.

You can specify a timer interval from 2 to 30 seconds.
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Other Features

Changing the File Saving Method
1 Click the [RemoteCapture Task] menu and select [Preferences].

For Mac OS 9, click the [File] menu and select [Preferences].
A window similar to the one in step 2 will appear.

2 Select a file settings option and click [OK]. 

Displaying the Subject in the Camera's LCD Monitor
You can view the subject you are shooting in the camera’s LCD monitor. 

1 Click the [File] menu and select [Camera Display Settings].
The Camera Display Settings dialog will display.

2 Select [Camera’s LCD monitor] and click [OK]. 
3 Click the  icon. 

Selecting [Computer only] in the "Save Images On" category 
allows you to shoot when there is no memory card in the 
camera or when the camera's memory card is full.

You can display the subject on a TV connected to the camera 
by selecting [Video Out terminal] in Step 2. See the Camera 
User Guide for instructions to connect the camera to a TV.

Sets whether images are saved only to the 
computer or to both the computer and the 
memory card in the camera.

Input a root name for the image files here. If 
you input “Capture”, for example, the first 
image will be named [Capture_00001.jpg] 
and successive images will automatically be 
assigned a name that is one number higher 
than the last. 
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Merging Panoramic Images - PhotoStitch 

You can create a wide panoramic image by merging several images, such as 
those shot in the camera's Stitch Assist mode.
Use the PhotoStitch program to merge the images.

Starting PhotoStitch 

Start PhotoStitch from ImageBrowser.

1 Select a series of images in the ImageBrowser’s Browser Area. 
2 Click the [Edit] menu and select [PhotoStitch].

A window similar to that below will appear.

3 Merge the images following the instructions in the guidance panel 
at the top of the PhotoStitch window.

Images shot in Stitch Assist mode with a wide converter, 
teleconverter or close-up lens cannot be merged accurately. 

Follow the instructions 
to merge the images.



M
acintosh - Advanced Techniques -

81

Images Shot in Stitch Assist Mode 

It is easy to merge images shot with the camera's Stitch Assist mode since 
PhotoStitch automatically arranges them in the correct order and orientation.
Stitch Assist mode images appear in the Camera Window as shown below. 

•You can also start PhotoStitch by clicking the mark shown on 
images shot in Stitch Assist mode.

•See the Camera User Guide for information about shooting in 
Stitch Assist mode.

Images shot in Stitch Assist mode 
display a mark like this. 
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Enjoy Customizing Your Camera with the 
My Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-
timer sound are called the My Camera Settings. You can add your favorite 
images and sounds from your computer to the My Camera Settings. This topic 
explains how to upload the My Camera Settings saved onto your computer to 
the camera and vice versa. Use ImageBrowser to perform this function.

Displaying the My Camera Window

To save the My Camera Settings to the camera, you use the My Camera 
window. The following explains the procedures for displaying the My Camera 
window. 

1 Connect the camera to the computer, start ImageBrowser and 
display the Camera Window. 
For starting instructions for ImageBrowser, see Starting ImageBrowser
(p. 60).

2 Click [Setup Options] in the Camera Window and select [My Camera] 
in the pop-up menu.

The Select My Camera dialog will display.
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3 Select [Start-up Image, Start-up Sound, Operation Sound, Selftimer 
Sound and Shutter Sound] and click [OK].
This will display the My Camera window. 

The My Camera Window

ImageBrowser already contains several pre-recorded My 
Camera Settings items. You can check these items with the 
My Camera window.

You can add new files as My Camera Settings to the My Camera 
window. See Adding New Data to the My Camera Window
(p. 85). 

Type 
Select the My Camera 
Settings type. 

Displays the list 
of My Camera 
Settings files 
saved onto the 
computer.

Add Button
Click here to add 
a file as one of 
the My Camera 
Settings to the 
My Computer list.

Play Button
Click here to play the 
selected sound setting.

Send to Trash Button
Click here to delete a 
setting from the My 
Computer list. 

Save to Camera Button
Click here to save the 
settings onto the 
camera. 

Delete Button
Deletes a setting 
from the Camera 
list.

Displays the My 
Camera Settings in 
the camera.

Play Button 
Click here to play 
sounds recorded onto 
the camera. 

Save to Camera
Save to Computer 
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Saving the My Camera Settings to the Camera

You can save the My Camera Settings displayed in the My Camera window to 
the camera. 

1 Confirm that the type of setting you wish to save to the camera is 
selected in the Type list box.

2 Select the setting from the Computer list that you would like to add. 
If you selected [Theme] in the Type category, the thumbnail (tiny version) of 
the start-up image will display to the right and the sound files will play in 
the order of start-up sound, shutter sound, operation sound and self-timer 
sound. 

3 Select the setting in the Camera list that you would like to change 
and click the  button.
The Camera list setting will change to the selected file. If a setting for this 
category has previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

4 Click the [Save to Camera] button.
This concludes the process of saving the My Camera Settings to the 
camera. 
To use this data on the camera, change the start-up image and sound 
settings on the camera itself. Please see the Camera User Guide for these 
instructions.

•My Camera Settings can be selected and saved in either of two 
ways to the camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the 
start-up image and animal calls in each of the sound files. The 
names of the prepared files for the various My Camera Settings 
themes all begin with the same root name, such as “Animal~”. 
For example, the start-up image that starts with “Animal~” 
shows an animal picture while the similarly named sound files 
feature animal sounds.

•Settings that do not appear in the My Computer list of the My 
Camera window cannot be saved to the camera. 

•Do not detach the USB cable, turn the camera power off or 
disconnect the camera from the computer while the My Camera 
Settings are being saved to the camera or the settings from the 
camera are being saved to the computer. 
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Saving the Camera’s My Camera Settings to the Computer

The My Camera Settings on the camera can be saved to the computer. 

1 Select the type of setting you wish to save to the computer from the 
Type list box.

2 Select the setting in the Camera list that you wish to save to the 
computer. 
If you selected Theme in the Type category, the thumbnail (tiny version) of 
the start-up image will display to the right and the sound files will play in 
the order of start-up sound, shutter sound, operation sound and self-timer 
sound. 

3 Click the  button.
4 Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera Settings to the 
computer. 

Adding New Data to the My Camera Window

To add new data to the My Camera window, you need to create the new data, 
save it to the computer and add that file to the My Camera window.

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will 
become the start-up image and save it to the computer. Create the file in the 
JPEG format at a size of (w) 320 x (h) 240 pixels.
Once you have created the data and saved it to the computer, use the following 
procedures to add it to the My Camera window.

1 Open the My Camera window, select the type of setting you wish to 
add from the Type list box.

My Camera Settings can be selected and saved in either of two 
ways to the computer: individually or in theme sets.
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2 Click the [Add] button.
This will display a dialog for opening files.

3 Select the file you created and click [Open].
The selected file will appear in the Computer list.
This concludes the process for adding new data.
You can save the newly created data to the camera using the procedures 
described in the Saving the My Camera Settings to the Camera section 
(p. 84).

Add an Original Sound File
Use a program such as ArcSoft VideoImpression to change the file format to the 
WAV format after you have copied the sound file. Then proceed with the steps 
on the previous page.

To delete a setting, select the file name and click the [Send to 
Trash] button at the bottom of the My Computer list.

•With Mac OS 9, you can use the standard-issue SimpleSound 
program to record a sound file.

•Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono 
sound in the WAV format. The following chart shows 
standard time lengths for My Camera Sounds.

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less



W
indow

s/M
acintosh

87

Appendices

This chapter introduces the CD-ROMs included in your package and the 
procedures for installing the programs. It also explains how to uninstall the 
programs.

Read the Troubleshooting section in this chapter if you experience a problem 
using the programs.
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About the CD-ROMs Supplied with the 
Solution Disk

CD-ROMs containing image editing programs are included in your camera 
package along with the Canon Digital Camera Solution Disk. This topic explains 
the program features and installation procedures for each CD-ROM.

ArcSoft Camera Suite 1.2 CD-ROM

This CD-ROM contains the following programs.

The free hard disk space required to install ArcSoft Camera Suite 1.2 is 475 MB 
or more on a Windows system and 375 MB or more on a Macintosh system.

What Can Be Accomplished with ArcSoft Camera Suite 1.2
Special Effects and Image Editing for Various Purposes
•ArcSoft PhotoImpression
This program can be used to apply special effects, and edit and print images in 
simple steps. It can also be used to create postcards and calendars.

Programs for Editing Stills and Movies
•ArcSoft VideoImpression
This program provides simple procedures for compiling a movie from multiple 
movie clips or stills and for editing out unwanted frames from movies.

The CD-ROMs supplied with the cameras differ by model. See 
Information about Your Camera for details (p. 105).

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ArcSoft 
PhotoImpression

ArcSoft 
VideoImpression
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Installing ArcSoft Camera Suite 1.2

Windows 

1 Place the ArcSoft Camera Suite CD-ROM in the drive.
Follow the onscreen messages to install PhotoImpression and 
VideoImpression.
If the message does not appear automatically, click the Windows [Start] 
menu, select [My Computer], and double-click the [ARCSOFT] and 
[Setup.exe] icons .
Windows 2000, Windows Me and Windows 98 users should double-click 
the [My Computer] icon on the desktop, followed by the [ARCSOFT] and 
[Setup.exe] icons  .

Macintosh
•Installing ArcSoft PhotoImpression

1 Close all programs that are running.
2 Place the ArcSoft Camera Suite CD-ROM in the drive.

3 Open the CD-ROM window and double-click the [PhotoImpression 

4], [English] and [PhotoImpression Installer] icons .

Installation will start.
Follow the onscreen messages to proceed with the installation.

4 Click [Finish] when the message stating that the installation is 
complete appears.
Continue by installing ArcSoft VideoImpression.

•Installing ArcSoft VideoImpression

1 In the CD-ROM window, double-click the [VideoImpression 1.6], 

[English] and [VideoImpression 1.6 Installer] icons .

Installation will start.
Follow the onscreen messages to proceed with the installation.

2 Restart the computer after the installation is complete.
This concludes the installation process for ArcSoft PhotoImpression and 
ArcSoft VideoImpression.
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to 
delete the programs from your computer or when reinstallation is required to fix 
corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk 
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a 
program.

1 Click the Windows [Start] menu and select [Programs] or [All 
Programs], followed by [Canon Utilities], [ZoomBrowser EX] and 
[Uninstall ZoomBrowser EX].

The uninstall utility will start and remove ZoomBrowser EX.

•You can remove other programs with the same procedures. 
•PhotoRecord can be uninstalled by clicking the Windows 

[Start] menu and selecting [Programs] or [All Programs], 
followed by [Canon PhotoRecord] and [Uninstall 
PhotoRecord].
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Uninstalling the Other Supplied Programs
ArcSoft PhotoImpression and VideoImpression 

Uninstall these programs by clicking the Windows [Start] menu and selecting 
[Programs] or [All Programs], followed by [ArcSoft Camera Suite] and 
[Uninstall].

Uninstalling the USB Driver (Windows)

Use the following procedures to uninstall the USB driver.

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital Terminal. Prepare the camera for communication 
with the computer.
For USB cable connection instructions, see Information about Your Camera
(p. 105). 
A dialog allowing you to select which application program to start will 
display.

2 Click the [Cancel] button.
If ZoomBrowser EX is started, close it.

3 Click the [Start] menu and select [Settings], followed by [Control 
Panel].

It is essential to note that you will not be able to download 
images if you uninstall the USB driver.  

This procedure is not required with Windows XP.
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4 Double-click the [Scanners and Cameras] icon or folder.

5 Delete your camera model name or [Canon Camera] in the [Scanners 
and Cameras Properties] dialog.
Windows Me users should delete their camera model or [Canon Camera] in 
the [Scanners and Cameras] folder.

Windows 2000/Windows 98
Select your camera model name or [Canon Camera] and click [Remove].

Windows Me
Select your camera model name or [Canon Camera], right-click the mouse 
and select [Delete].

If your camera model name does not appear here, see the 
Camera not detected, Events dialog won’t display or images 
will not download to the computer (p. 96) of the 
Troubleshooting section.

Your camera model name or 
[Canon Camera] will appear here.
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6 Click the Windows [Start] menu and select [Programs] or [All 
Programs], followed by [Canon Utilities], [Camera TWAIN Driver x.x]
and [Uninstall TWAIN Driver]. (A version number appears in place of 
the “x.x”.)
• Windows 2000, Windows 98: Perform Step 6 with no substitutions.
• Windows Me: Substitute the following for the underlined portions of 

Step 6.
[Camera WIA Driver x.x], [Uninstall WIA Driver] 

The uninstall process will start.

To connect the camera to the computer and download after this point, use 
the following procedures.
1. Reinstall the driver.
2. Connect the camera to the computer with the USB cable. 

Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which 
it was installed) into the Trash, and then empty the Trash.

Please be careful not to accidentally delete any folders with 
downloaded images that may be contained within the 
application folder. 
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Memory Card Folder Structure

The images on a memory card are placed in the [DCIM] folder in subfolders 
labeled [xxxCANON], where the “xxx” represents a number in the range 100 - 
998. 

•*Files with the THM extension are the thumbnail image files for the camera’s 
index replay mode.

•**Each successive file shot in Stitch Assist mode is assigned a letter starting 
from “A,” which is inserted as the third digit in the name. i.e. 
[STA_0001.JPG], [STB_0002.JPG], [STC_0003.JPG] ...

•The “xxxx” in file names represent four-digit numbers.
•All folders except the “xxxCANON” folders contain image settings files. Do not 

open or delete them. 

IMG_xxxx.JPG (JPEG format images)
CRW_xxxx.CRW (RAW format images)
CRW_xxxx.THM*
STx_xxxx.JPG** (Stitch Assist mode 
images)
MVI_xxxx.AVI (Movies)
MVI_xxxx.THM*
SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for 
images in the DCIM folder.

The folder created when DPOF settings are set. 
It holds the DPOF settings files.

DCIM

MISC

xxxCANON

CANONMSC
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer meet the following requirements?

Computer systems that fail to meet the following requirements to 
accommodate a camera connected by a USB cable are not 
supported. Please acquire the necessary system. 
• Built-in USB port on a system pre-installed with Windows XP, Windows 

2000, Windows Me, or Windows 98 (First or Second Edition)
• System with a genuine Apple Computer built-in USB port

Is the camera correctly connected to the computer?

See Information about Your Camera (pp. 105 - 109) for the correct 
connection procedures. Also check to ensure that you are using the 
correct cable and that it is securely attached at both ends. 

Is the camera set to the playback mode? (some models only)

Some models require the camera to be set to the playback mode to 
transfer data. See Information about Your Camera (pp. 105 - 109) 
for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a 
battery. You are recommended to use a household power source 
(AC adapter) to power the camera when it is connected to a 
computer (if available for your camera model).
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Problems

Try the suggested solutions to the common problems listed below.

USB driver installation not proceeding well (Windows)

Uninstall the driver (p. 91) before reinstalling it with the procedures in 
Installing the Software and USB Driver (p. 10). 

Add New Hardware Wizard or New Hardware Found (Windows 
2000) Wizard displays when the camera is connected to the 
computer with a USB cable.

Click [Cancel] to close the window. Temporarily disconnect the camera 
from the computer. Next, read Start by Checking This on the previous page 
and resolve the problem.

Camera not detected, Events dialog won’t display or images will 
not download to the computer (when camera is connected to the 
computer via a USB cable)

Cause 1:

There is a problem with one of the items in the Start by Checking 
This section (p. 95).
Solution:

Resolve the problem.
Cause 2:

The USB driver is not installed. (Windows only)
Solution:

Install it with the procedures in Installing the Software and USB Driver (p. 
10).
Cause 3:

The USB driver is not correctly installed. (Windows only)
Solution:

Uninstall the driver (p. 91) before reinstalling it with the procedures in 
Installing the Software and USB Driver (p. 10).
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Cause 4:

The camera may have been recognized as another device under the 
following circumstances. (Windows only)
• The camera was connected to the computer before the USB driver was 

installed.
• The [Scanners and Cameras] icon or the [Scanners and Cameras] folder 

cannot be found in the [Control Panel] or the [Printers and Other 
Hardware] window.

• Your camera model name, [Canon Camera] or a camera icon does not 
display in the [Scanners and Cameras Properties] dialog or the [Scanners 
and Cameras] folder.

Solution 1:

Start with the following procedures.
Install the USB driver with the procedures in Installing the Software and 
USB Driver (p. 10). Then connect the camera to the computer with the USB 
cable and prepare it to transfer data. If the USB driver is already installed, 
uninstall it first and then reinstall it.
Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue 
by implementing the following procedures. The specific steps are explained 
below.
1. Check to see if the camera is being recognized as an “other” device.
2. Delete the driver and the setup information files if it is being recognized 

as an “other” device.
3. Reinstall the driver.

This section explains the specific steps for each operating system.

Windows XP and Windows 2000 

<Check to see if the camera is being recognized as an “other” 
device and delete the driver if it is.>

1. Windows XP: Click the [Start] menu, followed by [Control Panel], 
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and 
[Control Panel]. Double-click the [System] icon.

2. Click the [Hardware] tab, followed by [Device Manager].

Users of Windows XP Professional and Windows 2000 must 
first log in as an Administrator (computer system 
administrator) to delete a driver.  
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3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 
category. Your camera model name or [Canon Camera] will display in 
these categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera], right-click and 
select [Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

6. Close the System Properties window.

< Delete the setup information files>

7. Double-click the [My Computer] icon on the desktop, followed by the 
[C:] drive, [Winnt] folder and [Inf] folder.

There are other potential reasons for the problem if the 
“Other devices” or “Imaging devices” categories do not 
appear or your camera model name or [Canon Camera] does 
not appear. Proceed to Step 6, temporarily quit the 
procedures and investigate the other potential causes.

Step 7 and above are not required for Windows XP.
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8. Look for files for Canon digital cameras that start with [Oem*]. 
The “*” represents a number, such as 0 or 1. 
[Oem*] files come in pairs of [Oem*.inf] and [Oem*.pnf] files. (For 
example, [Oem0.inf] and [Oem0.pnf]). 

9. Double-click the [Oem*] files to check their contents. 
Double-clicking an [Oem*.inf] file will open it in the Windows Notepad 
program. Look for [;***Canon Camera Driver Setup File****] in the 
first line. Note down the names of these files.

10.Delete the [Oem*] file set.
Delete the [Oem*.inf] and [Oem*.pnf] file for Canon digital cameras 
that you noted down in Step 9.

If the [Inf] Folder Is Not Visible in the [Winnt] Folder
Use the following procedures to show all files and folders.

1. Open the [Winnt] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Files and Folders] category in the Advanced Settings section, 

set [Hidden files and folders] to [Show hidden files and folders]. 
Remove the check marks from [Hide file extensions for known file 
types] if it is present.

5. Click [OK] to close the dialog.

This will make the hidden files and folders visible.

Several sets of [Oem*] files may be present in the [Inf] 
folder. Open up each file to confirm that it is an [Oem*] file 
for Canon digital cameras before you do anything with the 
file.
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<Reinstall the driver.>

11.Reinstall the driver with the procedures in Installing the Software and 
USB Driver (p. 10).

Windows Me/Windows 98 
<Check to see if the camera is being recognized as an “other” 
device and delete the driver if it is.>

1. Click the [Start] menu and select [Settings], followed by [Control Panel]. 
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.
3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 

category. Your camera model name or [Canon Camera] will display in 
these categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera] and click [Remove].
5. Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

The Inf folder contains numerous files critical to the 
computer’s operation. Be extremely careful to delete the 
correct files. If you delete the wrong files, you may be 
unable to restart Windows.

There are other potential reasons for the problem if the 
“Other devices” or “Imaging devices” categories do not 
appear or your camera model name or [Canon Camera] does 
not appear. Proceed to Step 6, temporarily quit the 
procedures and investigate the other potential causes. 
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6. Click [OK] to close the System Properties window.

< Delete the setup information files.>

7. Double-click the [My Computer] icon on the desktop, followed by the 
[C:] drive, [Windows] folder and [Inf] folder.

8. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
9. In the [Inf] folder, double-click the [Other] folder to open it.

10. Find and delete the [Canon.IncCAP_xxx.Inf] file. (The xxx 
represents numerals.)

If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

1. Windows 98: Click the [View] menu and select [Folder Options]. 
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
3. Windows 98: Set the [Hide files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show 
hidden files and folders]. 

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.

You do not need to delete anything if none of the above 
files are contained in the [Other] folder.
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<Reinstall the driver>

11.Reinstall the driver with the procedures in Installing the Software and 
USB Driver (p. 10).

“Server Busy” Displays During Image Download

Use the following procedures if a window similar the one below appeared when 
you downloaded images with ZoomBrowser EX running on Windows XP.

1. Click [Retry].

If the above screen appears again, click [Retry] until it disappears.

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in 
ZoomBrowser EX to slow down or malfunction. If this occurs, set your computer 
display's Hardware acceleration setting to a lower setting. 

1. Click the Windows [Start] menu, followed by [Control Panel] and 
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98, click the [Start] 
menu and select [Settings], followed by [Control Panel]. 

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] 
button and [Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] 
tab, [Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98, click the [Display] icon, followed by 
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

The [Inf] folder contains numerous files critical to the 
computer’s operation. Be extremely careful to delete the 
correct files. If you delete the wrong files, you may be 
unable to restart Windows.
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If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with 
Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 4 the titles and comments 
you input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in 
which you installed ZoomBrowser EX 4. (e.g. C:\Program 
Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility.
3. Select the database file you were using up to this point and click the 

[Start] button. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My 
Database.zbd)

This will display the titles and comments input in the earlier versions in 
the comments section of ZoomBrowser EX 4.

If You Had Images in a Folder Below the Program Files Folder
Image files in the [Program Files] folder or a subfolder cannot be displayed 
in ZoomBrowser EX 4 from that location. To display these files, first 
perform steps 1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains 
from the [Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser 
EX\Library One to another location.)

The moved folder images can now be selected and displayed with 
ZoomBrowser EX 4.
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Information about Your Camera

The software package and the procedures for connecting to a computer and 
preparing for data transfers vary between camera models. Certain software 
functions may also not be supported by some camera models. 

Read this section to confirm the capabilities of your camera model. 
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Information Common to All Models

See the respective page for your camera model for information specific to that 
model (pp. 108 - 109).

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all 
models. It contains the following programs.

Program

Compatible Operating System

Windows Macintosh

98 Me 2000 XP OS 9 OS X

ZoomBrowser EX

ImageBrowser

TWAIN Driver

WIA Driver

PhotoRecord

PhotoStitch
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Connecting the Camera to a Computer

•Your camera and computer
•USB cable supplied with the camera

See the page (pp. 108 - 109) for your specific model for information about 
connecting the camera to the computer.

Ensure that you have installed the software from the supplied 
Canon Digital Camera Solution Disk before you connect the 
camera to the computer. 

•Use the USB cable to attach the camera directly to a USB port on 
the computer, not through a USB hub. The connection may not 
operate correctly through a USB hub.

•The connection may not operate correctly if you are using other 
USB devices, excluding USB mice or keyboards, at the same time 
as the camera. If this occurs, disconnect the other devices from 
the computer and try reconnecting the camera.  

•Do not connect two or more cameras at the same time to the 
same computer via the USB interface. The connections may not 
operate correctly.

•Never allow the computer to go into standby (sleep) mode while 
a camera is connected via the USB interface. If it does happen, 
never disconnect the USB cable. Try to awaken the computer 
with the camera in the connected state. Some computers will 
not awaken properly if you disconnect the camera while they 
are in standby (sleep) mode. Please refer to your computer 
manual for instructions regarding the standby (sleep) mode.

You are recommended to power the camera from a household 
power source (AC adapter) when connecting to a computer (if 
available for your camera model). Ensure that you use fully 
charged batteries if you will not be using a household power 
source. 



PowerShot SD10 DIGITAL ELPH/DIGITAL IXUS i108

PowerShot SD10 DIGITAL ELPH/DIGITAL 
IXUS i 

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Set the mode switch to the playback mode and turn the camera’s 
power on. This will prepare the camera to exchange data with the 
computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 88) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

The camera shutter cannot be controlled from a computer.

USB Port

USB Cable

To the Digital 
Terminal

1. Open the terminal cover by slipping 
a fingernail under its left edge.

2. Insert it all the way until it clicks.
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PowerShot A80

How to Connect the Camera to a Computer and Prepare to Transfer Data

1 Attach the supplied USB cable to the computer’s USB port and the 
camera’s Digital terminal as shown below.

2 Set the mode switch to the playback mode and turn the camera’s 
power on. This will prepare the camera to exchange data with the 
computer. 

CD-ROMs in the Package

•Canon Digital Camera Solution Disk
•ArcSoft Camera Suite 1.2 
See ArcSoft Camera Suite 1.2 CD-ROM (p. 88) for information about the 
features and installation procedures for the programs on the disk. 

Non-Supported Programs and Features 

All programs and features are supported.

USB Port

USB Cable
1. Open the terminal cover by slipping a 

fingernail under the tab.
2. Insert it all the way until it clicks.

To the Digital 
Terminal
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Canon Customer Support
For Canon Customer Support contacts, please see the Canon Limited Warranty supplied 
with your camera.

ArcSoft Customer Support
North America 
46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions 
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.
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